Edvo-Kit #278

Quantitative ELISA

Experiment Objective:

In this experiment, students will master the concepts and methodology behind the quantitative enzyme-linked immunosorbent assay (ELISA). Students will perform an ELISA to detect the concentration of two different antigens. A standard curve will be created for each antigen to allow for accurate quantification in unknown samples.

See page 3 for storage instructions.
## Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Experiment Components</td>
<td>3</td>
</tr>
<tr>
<td>Experiment Requirements</td>
<td>3</td>
</tr>
<tr>
<td>Background Information</td>
<td>4</td>
</tr>
<tr>
<td>Experiment Procedures</td>
<td></td>
</tr>
<tr>
<td>Experiment Overview</td>
<td>7</td>
</tr>
<tr>
<td>Module I: Performing a Quantitative ELISA</td>
<td>8</td>
</tr>
<tr>
<td>Module II-A: Analysis of Quantitative ELISA</td>
<td>13</td>
</tr>
<tr>
<td>Module II-B: Quantitative Analysis</td>
<td>14</td>
</tr>
<tr>
<td>Study Questions</td>
<td>16</td>
</tr>
<tr>
<td>Instructor’s Guidelines</td>
<td></td>
</tr>
<tr>
<td>Notes to the Instructor</td>
<td>17</td>
</tr>
<tr>
<td>Pre-Lab Preparations</td>
<td>18</td>
</tr>
<tr>
<td>Avoiding Common Pitfalls</td>
<td>20</td>
</tr>
<tr>
<td>Experiment Results and Analysis</td>
<td>20</td>
</tr>
<tr>
<td>Study Questions and Answers</td>
<td>21</td>
</tr>
<tr>
<td>Appendix A: Student Worksheet</td>
<td>22</td>
</tr>
</tbody>
</table>

Safety Data Sheets can be found on our website: [www.edvotek.com/safety-data-sheets](http://www.edvotek.com/safety-data-sheets)
Experiment Components

COMPONENTS
Store components A-I in the refrigerator.

- A Antigen A
- B Antigen B
- C Dilution Buffer
- D Primary Antibody A
- E Primary Antibody B
- F 10x Wash Buffer
- G Secondary Antibody
- H ABTS
- I Stop Solution

REAGENTS & SUPPLIES
Store all components below at room temperature.

- Microtiter plates
- Transfer pipets
- Snap-top microcentrifuge tubes
- 5 mL tubes
- 15 mL conical tubes
- 50 mL conical tube

Requirements (not included with this kit)

- Distilled or deionized water
- Beakers (small, 100-150 mL recommended)
- Disposable lab gloves
- Safety goggles
- Automatic micropipettes and tips (5-50 µL for students, 200-1000 µL for teacher prep)
- Paper towels

None of the components have been prepared from human sources.
Organisms are incredibly complex, consisting of an elaborate mixture of proteins, carbohydrates, and nucleic acids. In addition, different organisms, and even different cells within an organism, can contain an entirely distinct mixture of these compounds. Because of this, examining the function of one specific protein can become extremely challenging.

Fortunately, scientists have developed tools to measure the presence, and in certain cases the concentration, of a desired protein in a complicated mixture. One of the most common of these is the Enzyme-Linked ImmunoSorbent Assay, or ELISA. The ELISA uses antibodies to determine if a specific protein is present in a sample. ELISAs are commonly performed to test patient samples, monitor environmental specimens, and to ensure food and drug safety.

An ELISA can be designed to provide qualitative or quantitative results. In a qualitative ELISA, the results will indicate if a sample is positive or negative for the target. This type of assay is simple to perform and is useful for situations where the exact concentration of molecules is not necessary, such as pregnancy or drug tests. Alternatively, quantitative ELISAs use a standard curve to determine the precise concentration of a substance in the sample. Because of this, quantitative ELISAs reveal more information about the sample, although they are also more complex and take longer to perform.

ANTIBODIES – THE FOUNDATION OF THE ELISA

The most important components in any ELISA are the specific antibodies that will be used to detect the target protein. Antibodies are specialized proteins consisting of four linked polypeptide chains: two identical “heavy chains” and two identical “light chains” that form a “Y” shaped molecule (Figure 1). The primary function of antibodies is to allow the immune system to distinguish between “self” and “non-self” proteins or polysaccharides. Every antibody will selectively bind to a unique target, known as an antigen, using sites at the ends of the short arms of the “Y”. The amino acid sequence in this region is variable, allowing for each antibody to recognize a unique epitope (a particular location within an antigen).

To create the antibodies used in scientific research, scientists inject animals (i.e. rabbits, goats, and guinea pigs) with the antigen of interest. In response to the injection, the animal’s immune cells create antibodies that recognize different epitopes of the antigen. Blood is recovered from the immunized animal and the antibody-containing serum is separated from the blood cells.

Because of their specificity, researchers can use antibodies to detect the presence of specific biomolecules (i.e. peptides, proteins, antigens and hormones) in a complex sample. Most ELISAs use a combination of two antibodies. First, a primary antibody is selected to detect the target protein. These antibodies are very specific and are
designed to only bind to a single protein. Next, a secondary antibody is chosen to target the primary antibody. For example, if the primary antibody is made from rabbit immune cells, a secondary antibody will be selected to identify rabbit proteins.

In addition to targeting the primary antibody, the secondary antibody is also covalently linked to a Horseradish Peroxidase (HRP) enzyme. This enzyme can oxidize certain substrates to produce a visible color change, which is used to indicate the presence of our target protein. For example, HRP can react with the substrate ABTS ((2,2′-Azino-bis (3-ethylbenzothiazoline-6-sulfonic acid)). In the presence of hydrogen peroxide, the HRP enzyme will oxidize ABTS, turning the clear solution a vivid blue-green. HRP has a high catalytic activity – the substrate turnover rates exceed $10^6$ per second – allowing us to quickly detect even the smallest amount of antigen present within the sample.

THE ELISA PROCEDURE

In the laboratory, ELISAs are performed in transparent plastic microtiter plates. Scientists add the test samples and controls to the wells of the plastic plate, where they non-specifically stick to the wells through hydrophobic and electrostatic interactions (Figure 2). This means that any protein in the sample, and not just the desired target, can stick to the plastic. Next, the primary antibody is added to the wells, and the mixture is allowed to incubate for a short time. This antibody specifically recognizes and binds to the target molecule (Figure 2). Therefore, if any target protein is present in the microtiter wells it will be recognized by the primary antibody.

Following a brief incubation period, the wells are washed to remove any primary antibody that did not bind with the antigen. After the wash, an HRP-linked secondary antibody is added to the wells where it recognizes and binds to the primary antibody (Figure 2). The excess secondary antibody is removed from the wells by washing several times with buffer. However, if the secondary antibody has bound to the primary antibody it will stay in the well.

Finally, a substrate solution of ABTS and hydrogen peroxide is added to each well. The HRP enzyme linked to the

![Figure 2: Optimized ELISA workflow](image)
secondary antibody can oxidize ABTS in wells where the antigen-antibody complex is present, turning the clear substrate solution blue-green.

Importantly, the enzyme-substrate reaction can only occur if every step of the ELISA was successful. If the target protein is not present in the sample solution, or if the concentration is too low, the primary and secondary antibodies will not have anything to bind to and will be washed out of the well. Similarly, even if the antigen is present it will not be detected if the wrong primary antibody is used. In each of these scenarios, there will be no HRP enzyme available and the ABTS substrate will remain colorless.

During a quantitative ELISA, some of the wells will contain solutions where the concentration of antigen is already known. These samples are commonly created by diluting the antigen to create a standard curve that contains a broad range of antigen concentrations. The intensity of substrate in the unknown samples can then be compared to the standard curve to determine an approximate antigen concentration.

In this experiment you will perform an ELISA to examine two different antigens in experimental samples. Primary Antibody 1 will only detect antigen A, while Primary Antibody 2 is specific for antigen B. Both primary antibodies can be detected by the same secondary antibody. Standard curves will be created for each pair of antigens and antibodies to allow for accurate quantification of the proteins. Finally, the specificity of the ELISA will be examined by swapping the antigen-antibody pairs.
Experiment Overview

EXPERIMENT OBJECTIVE:

In this experiment, students will master the concepts and methodology behind the quantitative enzyme-linked immunosorbent assay (ELISA). Students will perform an ELISA to detect the concentration of two different antigens. A standard curve will be created for each antigen to allow for accurate quantification in unknown samples.

LABORATORY SAFETY

1. Gloves and goggles should be worn routinely as good laboratory practice.
2. DO NOT MOUTH PIPET REAGENTS - USE PIPET PUMPS OR BULBS.
3. Always wash hands thoroughly with soap and water after handling contaminated materials.

LABORATORY NOTEBOOKS:

Address and record the following in your laboratory notebook or on a separate worksheet.

Before starting the Experiment:

• Carefully read the introduction and the protocol. Use this information to form a hypothesis for this experiment.
• Predict the results of your experiment.

During the Experiment:

• Record (draw) your observations, or photograph the results.

After the Experiment:

• Formulate an explanation from the results.
• Determine what could be changed in the experiment if the experiment were repeated.
• Write a hypothesis that would reflect this change.
Module I: Performing a Quantitative ELISA

1. **OBTAIN** tubes of concentrated Antigen A (A1) and Antigen B (B1), empty snap-top microcentrifuge tubes, and a tube of Dilution Buffer.

2. **LABEL** 5 tubes as A2-A6 for Antigen A, and a second set of tubes as B2-B6 for Antigen B.

3. Using a micropipette, **ADD** 150 µL of Dilution Buffer to each of the labeled microcentrifuge tubes from step 2.

4. **TRANSFER** 50 µL of antigen from tube A1 into tube A2.

5. Fully **MIX** the sample by pipetting up and down 5 times.

6. Using the same pipette tip, **TRANSFER** 50 µL from tube A2 into tube A3 and mix as in step 5.

7. **CONTINUE THRU A6.**

8. **REPEAT FOR ANTIGEN B.**

Creating the Protein Standard Dilutions

1. **OBTAIN** tubes of concentrated Antigen A (A1) and Antigen B (B1), empty snap-top microcentrifuge tubes, and a tube of Dilution Buffer.

2. **LABEL** 5 tubes as A2-A6 for Antigen A, and a second set of tubes as B2-B6 for Antigen B.

3. Using a micropipette, **ADD** 150 µL of Dilution Buffer to each of the labeled microcentrifuge tubes from step 2.

4. **TRANSFER** 50 µL of antigen from tube A1 into tube A2.

5. Fully **MIX** the sample by pipetting up and down 5 times.

6. Using the same pipette tip, **TRANSFER** 50 µL from tube A2 into tube A3 and mix as in step 5.

7. **CONTINUE THRU A6.**

8. **REPEAT FOR ANTIGEN B.**
Module I: Performing a Quantitative ELISA, continued

9. **OBTAIN** two microtiter ELISA plates and tubes of Unknown 1 and Unknown 2. Each plate contains 3 columns and 8 rows of wells.

10. Using a fine-tipped marker, **LABEL** the left column of each plate as “1”, the center column as “2”, and the right column as “3”. Finally, **DRAW** a line between rows 6 and 7 on both plates. You will only use the wells on the top section of each plate.

11. With a fresh pipette tip, **TRANSFER** 50 µL from tube A1 into the top left well of EACH plate (column 1, row 1).

12. With a fresh pipette tip, **TRANSFER** 50 µL from tube A2 into the well directly below the sample from step 11 (column 1, row 2).

13. **CONTINUE** THRU A6 for both plates.

14. **TRANSFER** 50 µL from tube B1 into the top center well of EACH plate (column 2, row 1).

15. **TRANSFER** 50 µL from tube B2 into the well directly below the sample from step 14 (column 2, row 2).

16. **CONTINUE** THRU B6 for both plates.

17. INCUBATE U1

18. INCUBATE U2

19. INVERT & TAP WASH

20. INVERT & TAP WASH, INVERT & TAP WASH

**ADDING THE ANTIGENS TO THE ELISA PLATES**

9. **OBTAIN** two microtiter ELISA plates and tubes of Unknown 1 and Unknown 2. Each plate contains 3 columns and 8 rows of wells.

10. Using a fine-tipped marker, **LABEL** the left column of each plate as “1”, the center column as “2”, and the right column as “3”. Finally, **DRAW** a line between rows 6 and 7 on both plates. You will only use the wells on the top section of each plate.

11. With a fresh pipette tip, **TRANSFER** 50 µL from tube A1 into the top left well of EACH plate (column 1, row 1).

12. With a fresh pipette tip, **TRANSFER** 50 µL from tube A2 into the well directly below the sample from step 11 (column 1, row 2).

13. **CONTINUE** to **TRANSFER** 50 µL of the remaining Antigen A samples in the appropriate wells of column 1 on both plates.

14. With a fresh pipette tip, **TRANSFER** 50 µL from tube B1 into the top center well of EACH plate (column 2, row 1).

15. With a fresh pipette tip, **TRANSFER** 50 µL from tube B2 into the well directly below the sample from step 14 (column 2, row 2).

16. **CONTINUE** to add **50 µL** of the remaining Antigen B samples in the appropriate wells of column 2 on both plates.
Module I: Performing a Quantitative ELISA, continued

17. With a fresh pipette tip, **TRANSFER** 50 µL from tube U1 into the top three wells of the right column of EACH plate (column 3, rows 1-3).

18. With a fresh pipette tip, **TRANSFER** 50 µL from tube U2 into the next three wells of the right column of EACH plate (column 3, rows 4-6).

19. **INCUBATE** both plates for 5 minutes at room temperature.

**REMOVAL OF SAMPLES AND WASHING THE WELLS**

20. **INVERT** the plates over the sink or a stack of paper towels to remove the samples. Gently **TAP** the plates 4-5 times onto a fresh paper towel. **DISCARD** the wet paper towels.

21. Using a transfer pipette, **ADD** Wash Buffer to fill each well, being careful not to overfill.

**NOTE:** To minimize cross-contamination it is important that you avoid spilling buffer into neighboring wells.

22. **REPEAT** step 20 to **REMOVE** the Wash Buffer.

23. Using the same transfer pipette, **REPEAT** the wash a second time. **INVERT** the strips onto fresh paper towels and **TAP**.
Module I: Performing a Quantitative ELISA, continued

24. Using a fine-tipped marker, LABEL one plate with "A" and the other with "B".
25. Using a new micropipette tip, ADD 50 µL of Primary Antibody A (AbA) to each sample well on plate A.
26. Using a new micropipette tip, ADD 50 µL of Primary Antibody B (AbB) to each sample well on plate B.
27. INCUBATE for 5 minutes at room temperature.
28. INVERT onto paper towels and TAP. WASH the wells twice as in steps 20-23.
29. Using a new micropipette tip, ADD 50 µL of the Secondary Antibody (2°AB) to each sample well on BOTH plates.
30. INCUBATE for 5 minutes at room temperature.
31. INVERT onto paper towels and TAP. WASH the wells twice as in steps 20-23.

ADDITION OF PRIMARY AND SECONDARY ANTIBODIES
Module I: Performing a Quantitative ELISA, continued

**ADDITION OF SUBSTRATE**

32. Using a new micropipette tip, **ADD** 50 µL of ABTS substrate to each sample well on BOTH plates.

33. **INCUBATE** the plate for 2-5 minutes at room temperature, or until color no longer changes in the wells with the highest antigen concentrations. **NOTE:** It is important that the reaction is not allowed to proceed for more than 10 minutes as the enzymatic reaction can saturate at the highest concentrations of substrate.

34. Using a new micropipette tip, **ADD** 50 µL of Stop Solution to each sample well on BOTH plates. Gently **TAP** plates to **MIX**.

35. **DOCUMENT** results by using a digital camera to take a picture. Placing the plates on a white sheet of paper or white light box can increase contrast between wells.

36. **PROCEED** immediately to Module II: Analysis of Quantitative ELISA.
Module II-A: Analysis of Quantitative ELISA

1. **OBSERVE** the color of the reactions in your standard curves on both plates. There should be a strong green substrate in the most concentrated wells that gradually fades in the wells that received more diluted samples (as you move down a column).

2. **CONFIRM** that the antibodies were only able to detect their specific antigens - Antibody A should only detect Antigen A – by examining column 2 in plate A and column 1 in plate B.

3. Using the standard curves, **ESTIMATE** the concentration of Antigens A and B in the two Unknown samples. Record your results in Table 3 on page 22.
Module II-B: Quantitative Analysis

The color intensity of each well can be determined using densitometry, the quantitative measurement of light absorption. In this ELISA the initial concentration of antigen determines how many molecules of ABTS are oxidized. Oxidized ABTS turns the solution green, which leads to more light absorption. Therefore, by measuring the sample color intensity in the standard curve wells of known concentration, we can establish a relationship between antigen concentration and light absorption. This relationship is described by the equation of the standard curve. Using the equation we can then estimate the original concentration of antigen in the unknown sample.

1. Calculate the mean gray value and the protein concentration for the standard curve wells of each antigen.
   a. SAVE the digital image of your results as a JPEG on the computer.
   b. OPEN the ImageJ program on your computer.
   c. Go to File > Open and open your image.
   d. Go to Image > Type > 32 bit.
   e. Go to Edit > Invert.
   f. Go to Analyze > Set Measurements and select “mean gray value”.
   g. CHOOSE the round selection tool and draw a circle around the first well.
   h. Go to Analyze > Measure. A new window titled results should appear. RECORD the results for “mean gray value” in your lab notebook or in the table below.
   i. Click back to the digital image of your results and use the mouse or arrow keys to MOVE the circle to next well. REPEAT step h for all remaining wells on both plates.
   j. COMPLETE Tables 1 and 2 (at right) using the mean gray values and the antigen concentrations from Table 3 on page 22.

**NOTE:** In digital images each pixel has a luminance – or light intensity – value which ranges from black (zero intensity) to white (full intensity). In Image J this value is called gray value. The mean gray value is calculated by adding all the gray values in a selection and then dividing by the total number of pixels.

<table>
<thead>
<tr>
<th>Well</th>
<th>Dilution</th>
<th>Mean Gray Value</th>
<th>Antigen A Concentration</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1:1</td>
<td></td>
<td>8 µg/mL</td>
</tr>
<tr>
<td>2</td>
<td>1:4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>1:16</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>1:64</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>1:256</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>1:1024</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Table 2: Calculations for the Standard Curve of Antigen B**

<table>
<thead>
<tr>
<th>Well</th>
<th>Dilution</th>
<th>Mean Gray Value</th>
<th>Antigen B Concentration</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1:1</td>
<td></td>
<td>8 µg/mL</td>
</tr>
<tr>
<td>2</td>
<td>1:4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>1:16</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>1:64</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>1:256</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>1:1024</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**OPTIONAL:** If a spectrophotometer is available, the absorbance of ABTS can be measured at 420 nm. Transfer the samples to the appropriate plate or cuvette and measure the absorbance of the standard curve and Unknown samples. The standard curve can then be used to accurately measure the concentration of antigens in the Unknown samples.
Module II-B: Quantitative Analysis, continued

2. Create a standard curve.
   a. **PLOT** the antigen concentration (x axis) against the mean gray value (y axis) for each standard concentration for Antigen A.
   b. **DRAW** a best-fit curve through the points in the graph (for best results we suggest using graphing software). Record the equation for your curve for use later.
   c. **REPEAT** Steps 2a and 2b for Antigen B.

   **NOTE:** The best-fit line may not pass through every data point.

3. Determine the concentration of target protein in the unknown samples.
   a. Find the mean gray values of the sample in the unknown wells as in step 1.
   b. Determine the average gray value for each unknown sample.
   c. From the Y-axis of the standard curve graph, extend a horizontal line from this absorbance value to the standard curve. At the point of intersection extend a vertical line to the X-axis and read the corresponding concentration. Alternatively use the equation of the best-fit curve to solve for x given the y value (see Figure 4). You will have to do this twice for each unknown - once for antigen A and again for antigen B.

   Based on your calculations, what is the concentration of each antigen in the unknown samples?

**Figure 3:** Plotting a Standard Curve.

**Figure 4:** Determining a Protein Concentration.
Study Questions

1. Describe an ELISA experiment beginning with the addition of antigen samples to the well and ending with the substrate color change reaction.

2. Why is it important to wash all of the wells between the addition of the components during the ELISA?

3. What can happen if the substrate is allowed to react for more than 10 minutes without adding the stop solution?

4. Why was it important to test Antibody A with Antigen B, and Antibody B with Antigen A?
OVERVIEW OF INSTRUCTOR’S PRELAB PREPARATION:

It is necessary to prepare the antigens, antibodies, and buffers prior to performing the experiment. All components should be kept at 4°C in the dark until needed. A student worksheet has been provided (page 22) to help students collect the necessary reagents and perform the experiment.

<table>
<thead>
<tr>
<th>Preparation for:</th>
<th>What to do:</th>
<th>When:</th>
<th>Time Required:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module I: Performing a Quantitative ELISA</td>
<td>Divide microtiter plates</td>
<td>Before the class period</td>
<td>5 min.</td>
</tr>
<tr>
<td></td>
<td>Prepare and Aliquot Reagents</td>
<td>Up to 1 week before the lab</td>
<td>30 min.</td>
</tr>
<tr>
<td></td>
<td>Prepare secondary antibody</td>
<td>Same day as the lab</td>
<td>10 min.</td>
</tr>
</tbody>
</table>

NOTE: This experiment is intended to be run over the course of a single lab period and should take approximately 45-60 minutes. If necessary, the experiment can be stopped after the first wash, step 23 on page 10. Instruct the students to add wash buffer to each well on their plates, carefully cover with plastic wrap or place into a plastic bag to prevent evaporation, and store the plates overnight at 4°C. We do not recommend storing the plates for longer than 24 hours before continuing the experiment.

MODULE I: PERFORMING A QUANTITATIVE ELISA

Preparing the Microtiter Plate:

1. As shown in the figure below, orient the microtiter plate so that the numbers 1-12 are at the top and the letters A-H are on the left.

2. Divide each plate on the dotted lines as shown in the figure. Each piece will contain 3 wells on one axis and 8 wells on the other axis. Each lab group will receive two pieces.
Pre-Lab Preparations - On The Day Of The Lab

Preparation of Antigen

The antigens used in this experiment are supplied as lyophilized proteins and must be rehydrated before use. Follow the directions below to prepare Antigens A and B as 8 µg/ml stocks. These will be used for students to create standard curves, as well as for the unknown samples.

1. Dispense 1.6 mL of the Dilution Buffer (Component C) into 10 microcentrifuge tubes and label as “Dilution Buffer”. Reserve the remaining buffer for preparation of the antigen samples.
2. Transfer 5 mL of Dilution Buffer (Component C) into a 15 mL conical tube. Label the tube “A1”.
3. Transfer approximately 0.5 mL of the Dilution Buffer from step 2 into the tube of Antigen A (Component A). Pipette up and down or vortex to mix.
4. Transfer the entire contents of the reconstituted Antigen A back to the 15 mL tube from step 2. Mix well.
5. Dispense 180 µL of reconstituted Antigen A into ten 0.5 mL snap-top microcentrifuge tubes. Label the tubes as “A1”. Save the remaining Antigen A for the Unknown Samples.
6. Using a fresh 15 mL conical tube, repeat steps 2-4 for Antigen B (Component B).
7. Dispense 180 µL of reconstituted Antigen B into ten 0.5 mL snap-top microcentrifuge tubes. Label the tubes as “B1”. Save the remaining Antigen B for the Unknown Samples.

Preparation of Unknown Samples

1. Label one 5 mL tube as “Un1” and a second tube as “Un2” and prepare the unknown samples using the dilution buffer and rehydrated antigens from the previous section.

<table>
<thead>
<tr>
<th>Sample</th>
<th>Dilution Buffer</th>
<th>Antigen A</th>
<th>Antigen B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unknown 1</td>
<td>2600 µL</td>
<td>1300 µL</td>
<td>50 µL</td>
</tr>
<tr>
<td>Unknown 2</td>
<td>3400 µL</td>
<td>20 µL</td>
<td>580 µL</td>
</tr>
</tbody>
</table>

2. Dispense 360 µL of Unknown 1 into ten 0.5 mL microcentrifuge tubes. Label the tubes as “U1”.
3. Dispense 360 µL of Unknown 2 into ten 0.5 mL microcentrifuge tubes. Label the tubes as “U2”.

Preparation of the Primary Antibodies

1. Transfer 12 mL of Dilution Buffer (Component C) into a 15 mL conical tube. Label the tube “AntiA”.
2. Carefully remove the stopper from the vial of Primary Antibody A (Component D) and transfer approximately 0.5 mL of the Dilution Buffer from step 1. Close the stopper and gently shake the glass vial to mix.
3. Transfer the entire contents of reconstituted Primary Antibody A back to the 15 mL tube from step 1. Mix well.
4. Dispense 1.1 mL of Primary Antibody A into 10 microcentrifuge tubes. Label the tubes as “AbA” or “1°A”.
5. Repeat steps 1-3 for Antibody B (Component E) using a fresh 15 mL conical tube.
6. Dispense 1.1 mL of Primary Antibody B into 10 microcentrifuge tubes. Label the tubes as “AbB” or “1°B”.

Preparation of 1x Wash Buffer

1. Add contents of the 10x Wash Buffer (Component F) to 540 mL of distilled water. Mix well.
2. Dispense 55 mL of the diluted wash buffer into a small beaker for each group. Label the beakers “Wash buffer”. Save the remaining Wash buffer for rehydrating the Secondary Antibody.
Pre-Lab Preparations - During the Lab Experiment

Dilution of the Secondary Antibody
*(Prepare on the same day as needed for the experiments.)*

**NOTE:** You must use DILUTE WASH BUFFER to prepare the secondary antibody.

1. Transfer 19 mL of diluted Wash buffer to a 50 mL conical tube. Label the tube “2°AB”.
2. Carefully remove the stopper from the vial of Secondary Antibody (Component G) and transfer approximately 0.5 mL of the Wash buffer from the tube in step 1. Close the stopper and gently shake the glass vial to mix.
3. Transfer the entire contents of reconstituted Secondary Antibody back to the 50 mL tube from step 1. Mix well.
4. Label 10 microcentrifuge tubes "2°AB" and dispense 1.9 mL per tube.

Preparation of ABTS Substrate and Stop Solution

1. Dispense 1.9 mL of ABTS (Component H) into 10 microcentrifuge tubes. Label the tubes as “ABTS”.
2. Dispense 1.9 mL of Stop Solution (Component I) into 10 microcentrifuge tubes. Label the tubes as “Stop”.

**NOTE:** Stop Solution can precipitate when stored at 4° C. If precipitate is seen, gently warm the solution to resuspend before aliquoting.

---

**Each Lab Student Group Should Receive:**

- 10 Empty 0.5 mL Microcentrifuge tubes
- 2 Microtiter plates (3x8 well)
- 1 Microcentrifuge tube containing 1.6 mL Dilution Buffer
- 1 Microcentrifuge tube containing 180 µL Antigen A (A1)
- 1 Microcentrifuge tube containing 180 µL Antigen B (B1)
- 1 Microcentrifuge tube containing 360 µL Unknown 1 (U1)
- 1 Microcentrifuge tube containing 360 µL Unknown 2 (U2)
- 1 Microcentrifuge tube containing 1.1 mL Antibody A (AbA)
- 1 Microcentrifuge tube containing 1.1 mL Antibody B (AbB)
- 1 Microcentrifuge tube containing 1.9 mL Secondary Antibody (2°AB)
- 1 Microcentrifuge tube containing 1.9 mL Substrate (ABTS)
- 1 Microcentrifuge tube containing 1.9 mL Stop Solution (Stop)
- 1 Transfer pipet
- 1 Beaker containing 55 mL 1X PBST Wash Buffer
- Paper towels
**Avoiding Common Pitfalls**

1. Students should be advised to be very careful when transferring solutions into and out of the microtiter plate wells.
2. Use only clean or appropriately labeled pipets.
3. Wash the wells gently and slowly, without force.

**Experiment Results and Analysis**

A representative ELISA can be seen below. The intensity of the reactions will vary slightly due to differences in incubation times and the temperature of reagents, but the results should be similar.

Unknown samples should be compared to the standard curves to determine the concentration of antigen in each sample.
Please refer to the kit insert for the Answers to Study Questions
Student Worksheet

Each Student Group should receive:
10 Empty 0.5 mL Microcentrifuge tubes
1 Microtiter plates (3x8 well)
1 Microcentrifuge tube containing 1.6 mL Dilution Buffer
1 Microcentrifuge tube containing 180 µL Antigen A (A1)
1 Microcentrifuge tube containing 180 µL Antigen B (B1)
1 Microcentrifuge tube containing 360 µL Unknown 1 (U1)
1 Microcentrifuge tube containing 360 µL Unknown 2 (U2)
1 Microcentrifuge tube containing 1.1 mL Antibody A (AbA)
1 Microcentrifuge tube containing 1.1 mL Antibody B (AbB)
1 Microcentrifuge tube containing 1.9 mL Secondary Antibody (2′AB)
1 Microcentrifuge tube containing 1.9 mL substrate 2 (ABTS)
1 Microcentrifuge tube containing 1.9 mL Stop Solution (Stop)
1 Transfer pipet
1 Beaker containing 55 mL 1X Wash Buffer
• Paper towels

Table 3: Dilutions and Concentrations of Standard Curves

<table>
<thead>
<tr>
<th>Row</th>
<th>Dilution</th>
<th>Concentration</th>
<th>Dilution</th>
<th>Concentration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row 1</td>
<td>----</td>
<td>8 µg/mL</td>
<td>----</td>
<td>8 µg/mL</td>
</tr>
<tr>
<td>Row 2</td>
<td>1:4</td>
<td></td>
<td>1:4</td>
<td></td>
</tr>
<tr>
<td>Row 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Row 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Row 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Row 6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

UNKNOWN 1

Antigen A:_____________________________
Antigen B:_____________________________

UNKNOWN 2

Antigen A:_____________________________
Antigen B:_____________________________